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Using this Tutorial

To progress to the next topic press the right cursor key or click anywhere in the 
current topic.  To go back press the left cursor key. You can also go to any topic by 
using the shortcut menu as shown.

Simply right click anywhere in the current topic, point 
to Go, point to By Title and click the required topic.

There is also a main table of 
contents and individual chapter 
tables of contents.  These tables 
show underlined chapter or topic 
headings.  Click any of the table 
entries to go immediately to the 
selected option.

You can exit the tutorial at any time by pressing ESC.

To return to the main table of contents click 
To return to the table of contents for the current chapter click

Contents
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W elcom e

This tutorial guides you through the basic steps needed to use TheRecord Annotator.

What is TheRecord Annotator?
TheRecord Annotator is an electronic note-taking program that provides a 
comprehensive method for annotating proceedings.  When used in conjunction 
with TheRecord Recorder and TheRecord Player, Annotator provides an 

d t   th   l  t   b  t ti ll  ddi   li k t  h advantage over the paper log note process by automatically adding a link to each 
note. By linking the log notes to TheRecord content you can quickly locate 
specific events in recordings.
You can create notes while recording is 
active or when playing back existing 
recordings.  You can also create 
standalone notes   These notes can be standalone notes.  These notes can be 
linked to a recording at a later time. 
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Chapter 1 -Introduction

In this chapter you will find information on the following topics:In this chapter you will find information on the following topics:

Starting the Program
TheRecord Annotator ComponentsTheRecord Annotator Components
Sizing and Positioning
Column Widths
TheRecord Annotator Options
Navigator
Q itti  th  PQuitting the Program
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Starting the Program

Prior to working with TheRecord Annotator, you must start the program and 
familiarize yourself with the operating environment and the basic methods of 
operation.  

Double-click the TheRecord Annotator

To start Annotator:  

desktop icon      ,

-or-

Click Start  point to All Programs  then Click Start, point to All Programs, then 
ForTheRecord and click TheRecord 
Annotator.
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TheRecord A nnotator Com ponents

The main components of the Annotator window are the Title Bar, Menu Bar, Toolbar, 
Log Sheet, and the Audio Bar.  The audio bar is referred to in later sections 
describing range setting and playing audio.

Title Bar

Menu Bar
Toolbar

Range Bar

Contents Log SheetChapter 1



Sizing and Positioning

If not maximized the Annotator window can be resized and positioned anywhere on 
the screen. The minimum height of the window always includes the toolbar, the menu 
bar, the log sheet heading and one log sheet row. The minimum width always 
di l  th  Ti  l  d  i i  l  idth f  th  S k  d N t  displays the Time column and a minimum column width for the Speaker and Note 
fields.

Minimum window width

To position the Annotator 
window drag any part of the 
log sheet surrounds that is 

Minimum window width

not a button or display while 
it is not maximized.

To resize the window 

Minimum 
window 
height

drag any a window 
edge or corner until 
you reach the 
required size
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Title Bar

The Title Bar displays the first line of the Description field, date the log sheet was 
created or the date of the linked audio, and the Location Name.  

Title BarTitle Bar
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The Tool Bar

The toolbar contains buttons providing quick mouse access to the main Annotator 
functions.  From the tool bar you can create, open, copy and print a log sheet.  You 
can also toggle between edit mode and read-only mode, find text in a log sheet and 

 th  t d d t l  Gl i  Pi k Li t  M d Filtuse the standard tools Glossaries, Pick Lists, Merge and Filter.

Open Prin
t

Find Text

Save Copy As Edit/Read-onlyNe
w

Tools
w
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The M enu Bar

From the File menu you can create, open, copy, print and exit Annotator.

The Menu Bar provides access to the main 
functions and settings for Annotator.  

From the File menu you can create, open, copy, print and exit Annotator.
From the Edit menu you can switch between Edit and Read-only mode, apply 
formatting, cut copy and paste a selection, delete a log note, find text and synchronize 
log noteslog notes.
From the View menu you can set Always on Top, and toggle the Toolbar and Status bar  
on and off.
F  th  A ti    li k t t d t th   t t d dFrom the Actions menu you can link content and set the range start and end.
From the Tools menu you can access the standard tools Glossaries, Pick Lists, Merge
and Filter, and Annotator Options.
The Window menu contains a list of all loaded log sheets.
From the Help menu you can access Annotator Online Help, What’s This Help and 
Annotator version information.
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The Range Bar

The Range Bar provides a visual indication that the log sheet is linked to the content 
currently loaded in TheRecord player. The Range Bar appears in the narrow black strip 
to the left of the log sheet after the log sheet is linked to content.

Range Start Marker
This tab represents the range start time as defined in Recorder or

Audio Start
The top of the thin blue line indicates the start of the linked content.

Current Log Note Marker
This indicates the last log note relative to the current play time of

This tab represents the range start time as defined in Recorder or 
Player. Further information on defining ranges can be found in 
Chapter 4 – Reviewing Log Sheets.

This indicates the last log note relative to the current play time of 
the associated content.  As the content continues to play the 
current log note marker moves to show the corresponding log 
note.
Range End Marker
This tab represents the Range end time as defined in Player.

Audio End
The bottom of the thin blue line indicates the end of the linked content.

This tab represents the Range end time as defined in Player.  
Further information on defining ranges can be found in 
Chapter 4 – Reviewing Log Sheets.
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The Log Sheet

The log sheet consists of the Heading section and the Notes section. The Log Sheet 
Heading contains three fields that are used to identify log sheets: Description, Date
and Location.

Heading

Notes

Contents Chapter 1



Log Sheet H eading

The Log Sheet Heading contains three fields that are used to identify log sheets.

The Description field contains text 
entered by the user and is commonly 

The Date field contains 
the date of the 

The Location field identifies 
the venue in which the y y

used to identify the proceeding.  For 
example this might contain a case 
number, case name, name of the 
presiding officer and appearances.

proceedings.  

The date could be the 
current date or the date of 
an existing recording that 

proceedings occur. 

You can enter your own text 
in this field; choose from a 
list of previously used entries 

When not selected the Description field 
only displays the first line of text.  To 
expand the field select it or click the      
button to the right of the field.  When 
expanded the Description field shows a

g g
is loaded in TheRecord 
Player.

p y
or accept the automatic entry 
that appears if TheRecord 
Recorder or TheRecord 
Player is running.  

expanded the Description field shows a 
maximum of ten lines.  

To view additional lines use the scroll 
bar.
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Log N otes

Log Notes are primarily used to describe events that occur during proceedings.  They 
are organized and referenced by a Time column, a Speaker column and a Note
column.  Each row represents one time stamped log note. The titles of the Speaker 

f ffand Note fields can be changed.  Yours may appear differently to what is shown 
below. 

Time 
Column

Speaker 
Column

Note 
Column

A LogA Log 
Note

As each log note is created a Timestamp is automatically 
entered as a Log Note, and cannot be edited.

Row Selector
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Colum n W idths

The Speaker and Note columns in the log sheet are re-sizeable.  Either column 
(not both) can be reduced to a minimum readable width of 20 characters. Either 
column (not both) can also be “hidden” to a width of three pixels.  If the “hidden” 

fcolumn contains text then the title bar of the hidden column appears red.
The hidden Speaker column

To resize or hide the column move the pointer over the border between the 
S k  d N t  l  til it h  t   i i  i t   D  th  l  Speaker and Note column until it changes to a sizing pointer.  Drag the column 
border left to reduce the size of the Speaker column or right to reduce the size of 
the Note column.  The minimum readable width stops at 20 characters but 
dragging beyond this collapses the column to a hidden width of 3 pixels   To dragging beyond this collapses the column to a hidden width of 3 pixels.  To 
unhide a column drag the border between the hidden column and the visible 
column until the column border suddenly re-appears.
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TheRecord A nnotator O ptions

The Save Location, Window Size and Position, Time Stamp Offset and Column 
Titles can be changed in Annotator Options by selecting Options from the Tools 
menu.
The Save Location sets the folder in which new log 
sheets are stored.

The window settings can be saved so that all existing 
log sheets or new log sheets are opened at thelog sheets or new log sheets are opened at the 
same Window Size and Position.

Select this option to enable the Accessibility features.

The Time Stamp Offset is a value between zero and ten 
seconds and specifies how much each new log note 
is trimmed.  This is useful to compensate for the time it 
takes to recognize the need for a log note.

The default column titles are Time, Speaker and Note.  
You can change the Speaker and Note titles.  The 
new titles apply to any new log sheets created after 
the change.
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N avigator

Navigator is a special folder in Windows Explorer that is located in My Computer.  It 
is the default search location for TheRecord Player and TheRecord Annotator. When 
first installed Navigator is empty. You control what is displayed in Navigator by 
adding Search Folders. In most case Search Folders are set up by the IT support 
staff at installation time.

Typical Search Folders include: the 
network location where recordings are 
archived; the Recordings Folder for a 
Recorder; the network folder where Recorder; the network folder where 
Annotator log sheets
are saved; Your local CDROM.

Search folders make it simple to locate and 
open recordings without knowing the path 
to the storage location.  

Contents
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Creating Search Folders 

There are two ways to create a Search Folder.  You can create a new folder using the 
New Search Folder Wizard or you can add an existing folder to Navigator.

For more information on creating Search Folders see your TheRecord Annotator For more information on creating Search Folders see your TheRecord Annotator 
User’s Guide.
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Folder View

The first level of subfolders under Navigator are Search Folders.  The Search Folders 
point to locations that contain FTR content and are user defined.  The order in which 
the Search Folders are displayed 
in Navigator is also user defined.

S hSearch 
Folders
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List View

The right pane of Explorer (list view) shows the contents of the selected folder.  When 
you select the lowest level folder
in Navigator (location or date
depending on your sort order) the
content type is listed in the right
pane.

Search Folder
Date Folder

Location Folder

C t t t i li t d iContent  type is listed in 
the right explorer pane
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Sort O rder 

By default the contents of Search Folders are sorted into Date then Location folders.  
You can change the order to sort by Location then Date.

T  h  th  D t /L ti  t To change the Date/Location sort 
order right click the required 
Search Folder, then click Sort by 
Location from the shortcut menuLocation from the shortcut menu.
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Q uitting the Program

To close a log sheet click the Close button.

To quit the TheRecord Annotator program close each log sheet or select Exit from the 
File menu.  When you click Close on the last open log sheet you quit the program.File menu.  When you click Close on the last open log sheet you quit the program.

Close button

Select Exit from the File
menu to quit Annotator
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Chapter 1 – Review  Checkpoint

The following list summarizes the skills covered in the previous chapter:The following list summarizes the skills covered in the previous chapter:

�Starting the Program
�TheRecord Annotator ComponentsTheRecord Annotator Components
�Sizing and Positioning
�Column Widths
�TheRecord Annotator Options
�Navigator
��Quitting the Program
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Chapter 2 – Creating Log Sheets

In this chapter you will find information on the following topics:In this chapter you will find information on the following topics:

General Information
C ti   St d l  L  Sh tCreating a Stand-alone Log Sheet
Creating an Associated Log Sheet

Contents



G eneral Inform ation

When you create a new log sheet it is always in edit mode with a white background.
The Location field has an associated list of the ten most recently used location 
names.  To open the list, click the     button to the right of the field. 

Edit/Read-Only button

Click to open the Location
list

In Edit Mode the background is white

Changes to the new log sheet are automatically saved to the default Save Location.  
Saves occur 60 seconds after a change is made or when you move to another field 
after a change.

Contents
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Creating a Stand-A lone Log Sheet

Stand-alone log sheets are created when there is no access to the currently 
recording audio.   You might create a stand-alone log sheet if you want to create your 
own notes for later review.

1 Start TheRecord Annotator, or click the New button if Annotator is already started.

New
button

2 Enter a Description for the proceedings.

3 Enter a Location name for the 
proceedings or select a Location nameproceedings, or select a Location name 
from the list of previously used names.

4 Enter Log Notes in the log sheet.  The 
timestamps are based on yourtimestamps are based on your 
computer's system clock.

ContentsContents Chapter 2



Creating an A ssociated Log Sheet

Creating an associated log sheet requires access to TheRecord Player.   An association 
exists when the Date and Location information of the log sheet matches the information 
in the recording.  If an association exists then the log sheet and recording can be linked.

You can create an association to:

A recording that is in progress and is open in TheRecord Player  
-or-
Existing content that is loaded in the TheRecord Player

L ti d D t i f ti bt i d

In both cases the Location information is found in the the most recent list and appears 
between angled brackets as pictured below.
Location and Date information obtained 
from TheRecord Player
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A ssociating the Current Recording

1 Start TheRecord Recorder and Player, and then start 
Annotator.

From Recorder start recording and click the Play At2 From Recorder start recording and click the Play At 
End button to load the current recording into Player.

The Location information is obtained  from
Player and inserted automatically in the
L ti fi ld f th L Sh t

3

Location field of the Log Sheet.

If you start TheRecord Annotator first you can 
select the location name from the Location
field list.  The first entry is obtained from the
Player and is enclosed in <brackets>.

Contents

Player and is enclosed in brackets .
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A ssociating an Existing Recording

1 Start TheRecord Player and open the 
required content. 

2

The Location information is obtained 
from Player and inserted 
a tomaticall in the Location field of

Start Annotator.

3

automatically in the Location field of 
the Log Sheet.

If you start TheRecord Annotator first you can 
l t th l ti f th L tiselect the location name from the Location 

field list.  The first entry is obtained from the
Player and is enclosed in <brackets>.

Contents Chapter 2



Chapter 2 – Review  Checkpoint

The following list summarizes the skills covered in the previous chapter:The following list summarizes the skills covered in the previous chapter:

�General Information
�Creating a Stand-alone Log SheetCreating a Stand-alone Log Sheet
�Creating an Associated Log Sheet

Contents Chapter 2



Chapter 3 – Log N otes

In this chapter you will find information on the following topics:In this chapter you will find information on the following topics:

Navigating the Log Sheet
Entering Log NotesEntering Log Notes
Formatting Text
Deleting a Log Note
Glossaries
Pick Lists
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N avigating the Log Sheet

You can move around the fields of a log sheet using the keyboard or mouse. By 
using standard keyboard keys such as TAB and the arrow keys, as well as some 
specific keyboard shortcuts, you can move between the heading and notes fields of a specific keyboard shortcuts, you can move between the heading and notes fields of a 
log sheet entirely by keystrokes. Some keyboard actions differ between edit mode 
and read-only mode.  See your User’s Guide or Quick Reference Card for keyboard 
shortcuts.

Three important keyboard navigation keys are:

CTRL+HOME moves to the Description field

ALT+HOME moves to the first Speaker field

CTRL+END moves to the last Speaker field  

The standard scroll bar tools for mouse navigation also apply as well as simply 
clicking any required field.
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Entering Log N otes

To enter a log note, move to the last row in either the Speaker or Note field.  Press 
ENTER to move to the last empty Speaker field, and if you require the Note field then 
press TAB.  Once the Speaker or Note field is selected, start typing or select an entry 
f G O f f ffrom a Glossary or Pick List.  On the first entry in the selected field, the Time field is 
automatically updated to match the current time of the recording, or the current play 
time of playback audio or the system time for a stand-alone log sheet.
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Form atting Text

While creating log notes it may be helpful to highlight certain events by formatting 
the text.  The style of the text can be changed to bold, italic or underline, and you can 
choose one of 14 colors.

To apply formatting:

Select existing text, or position the 
cursor where new formatting is to start.  

1

2 Right click and select Format Text
from the shortcut menu.

3 From the Select Format dialog box 
select a style and color and click OK.
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D eleting a Log N ote

It sometimes occurs that a log note is created in error or becomes redundant.  You 
can delete a single log note whenever the log sheet is in edit mode.  To delete, right 
click anywhere in the required log note and click Delete Log Note in the shortcut 
menu.
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G lossaries

A Glossary is a collection of commonly used words and phrases.  Each word or 
phrase may be assigned a keyboard shortcut, which provides a rapid means of 
insertion into a log note.  With Annotator, multiple glossaries can be defined and 

ffmanaged so that different case types can have the relevant glossary attached.  
However, only one glossary can be active or open at any one time. 

Annotator is supplied with a Standard glossary containing a basic set of commonly Annotator is supplied with a Standard glossary containing a basic set of commonly 
used entries and an empty Custom glossary.  You can edit, add or delete entries from 
either or you can create your own glossaries.  Multiple glossaries are useful if you 
deal with a variety of proceedings that each have unique events   Simply select the deal with a variety of proceedings that each have unique events.  Simply select the 
relevant glossary as required.

For detailed information on creating your own glossaries see the TheRecord g y g
Annotator User’s Guide.
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Selecting a G lossary

To enter glossary items into the log sheet, be sure to select the required glossary 
first.  Once selected you can open the glossary to make it visible.  You can then 
select an item from the open glossary or you can use the assigned shortcut keys. 

To select a glossary:

From the menu bar click Tools, or from the 
toolbar click the Tools button

1
toolbar click the Tools button.   

2 From the Tools menu select Glossaries. 

3 In the Select Glossary dialog box the 
currently selected glossary is highlighted 
with an asterisk (*). To select a glossary 
without opening the glossary, select the 
required glossary from the Glossary List.

Click Apply (which will leave the dialog box 
open), or OK (which will close the dialog 
box).

4

q g y y

Contents
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O pening a G lossary

While working in a log sheet you can insert glossary text into a log note by selecting 
it from an open glossary.

To open a glossary:

From the Tools menu select Glossaries. 

1

2

From the menu bar click Tools, or from the 
toolbar click the Tools button.   

I th S l t Gl di l bIn the Select Glossary dialog box 
select the required glossary from 
the Glossary List and click Open.  

3

To

4

To resize the Glossary dialog 
box drag any a edge or corner 
until you reach the required 

Contents

size.  
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M odifying G lossary Entries

Once you have selected a glossary you can create new entries and edit or delete 
existing entries.

To edit the selected entry click EditTo edit the selected entry click Edit 
to open the New/Edit Entry dialog 
box.

Click Delete to delete 
the selected entry.  

To create a new entry click 
New to open the New/Edit 
Entry dialog box.
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N ew /Edit Entry

Once you have selected a glossary you can create new entries and edit or delete 
existing entries.

C t k h t k b d

If required enter a New key
combination for the
keyboard shortcut.  Entering 
a keyboard shortcut is

Current key shows current keyboard 
shortcut.

The Label is a user friendly 
name for a glossary entry and 
is optional. If no Label isa keyboard shortcut is 

optional but if it is not 
specified the entry can only 
be inserted in the log sheet 
from an open glossary.

is optional.  If no Label is 
entered then the glossary entry 
is displayed in the open 
glossary.

Each glossary entry can 
i l d C t l

Enter the required 
Glossary Entry text.

include one or more Control 
Codes that are used to 
automatically position the 
cursor in relevant fields.

Click OK to add the 
entry to the current 
glossary.
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M anaging G lossaries

Annotator is supplied with two glossaries called Standard and Custom.  You can 
rename, copy or delete these glossaries and add more as required.  Whenever you 
rename, copy or add a glossary it becomes the current glossary.

To add a new glossary click New…
and enter a glossary name in New 
Glossary dialog box.  To copy an existing glossary click 

Copy As… and enter a glossary 
name in Copy Glossary As dialog 

To rename an existing glossary 
click Rename… and enter a 
glossary name in Rename 
Glossary dialog box.  

py y g
box.  

To delete a glossary click Delete…
and click Yes in the confirmation 
di l bdialog box.  
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Inserting Text Using G lossaries

To insert a glossary item into the log sheet, select it from the open glossary or use 
any assigned shortcut keys.  Note that a glossary does not have to be open to use 
shortcut keys.  To enter a glossary item from the open glossary, either select the Type 

fthe item….. box and start typing to find the item and then press ENTER - or click the 
required item and press ENTER - or double click the required item.  The selected item 
is inserted into the log sheet.
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Pick Lists

A Pick List is a special text file that contains predefined blocks of text relevant to a 
particular matter.  Pick Lists are not created by Annotator.  They can be created by 
programs and stored in a folder that is accessible to Annotator.  Once a Pick List is 

fopened you can select items from the list and insert them directly into your log sheet.  
You can open multiple Pick Lists.

This Witness List is an 
example of a Pick List

This Case List is an 
example of a Pick List
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O pening Pick Lists

To open one or more Pick Lists :

From the menu bar click Tools, or 
from the toolbar click the Tools 
button.

1

From the Tools menu select Pick Lists. 2

3 If required, specify a Pick List Location.  

Select one or more Pick Lists. 

3

4

Click OK.  5
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Inserting Text using Pick Lists

To enter a pick list item using the open pick list either:

Select the Type the item… box, start typing 
A to find the item and then press ENTER. 

Click the required item and press ENTER.

A

B

Double click the required item.

Th l t d it i i t d i t th l

C

The selected item is inserted into the log 
sheet.
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Chapter 3 – Review  Checkpoint

The following list summarizes the skills covered in the previous chapter:The following list summarizes the skills covered in the previous chapter:

�Navigating the Log Sheet
�Entering Log NotesEntering Log Notes
�Formatting Text
�Deleting a Log Note
�Glossaries
�Pick Lists
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Chapter 4 – Review ing Log Sheets

In this chapter you will find information on the following topics:In this chapter you will find information on the following topics:

Opening Log Sheets
Finding Text

Filtering Log Notes
Linking ContentFinding Text

Selecting Text
Copying Log Sheets

Linking Content
Selecting Ranges
Synchronizingpy g g

Merging Log Sheets
y g

Playing Recordings
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O pening Log Sheets

When opening log sheets you can use TheRecord Navigator to find content that 
complies with the FTR file naming convention.

To open logs sheets:To open logs sheets:

From the toolbar, click the Open button.

From the Open dialog box use the Look in:

1

From the Open dialog box use the Look in:
box, and the Back or Up one level
buttons to navigate through Search 
Folders, Date folders and Location folders
until you reveal a content type.  
FTR Gold content is listed as FTR Log

2

FTR Gold content is listed as FTR Log 
Sheets (.fls).

When the required content is revealed 
select it and click Open. All log sheets in3 select it and click Open.  All log sheets in 
the selected Search Folder, with the same 
location name and date, are opened.

3
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Finding Text

While reviewing a log sheet, it may be necessary to quickly locate notes pertaining to 
a particular event, speaker or comment. Use Find Text as a fast and effective method 
for searching the currently open log sheet for any occurrences of a specific word or 
phrase in the current log sheet.

To  find a word in a log sheet:

From the toolbar click the Find Text
button.

In the Find Text dialog box, enter the text 
you wish to find

1

2
you wish to find.

Click Find.  The Find Text dialog box is 
closed and the first occurrence of the 
required text is highlighted in the log sheet.

3

To locate the next occurrence of the 
required text press ALT+F3.

required text is highlighted in the log sheet.

4
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Selecting Text

While working with Annotator you can select text or one or more log notes that can 
then be formatted, deleted, copied to a new log sheet or printed.
To select text within a log note field:

Row SelectorT l t

Position the cursor in the first word and 
either double click the word to select the 
current word or drag the cursor over the 
required text.

1

Row SelectorTo select one or more rows:

Move the mouse pointer over a row 
selector.  When the pointer changes to a 
black arrow as shown, click to select the 
current row.

1

To select multiple adjacent rows press 
SHIFT and click the Row Selector of the 
last required log note.

2

-or-

To select non adjacent rows move to 
another row and press CTRL while clicking 
to add the row to the current selection.

Contents Chapter 4



Saving and Copying Log Sheets

You can save a copy of the current log sheet, or a selection of notes from the current 
log sheet, to another location.

To save a copy of a log sheet, or a selection of notes:

If required, select the relevant notes (when saving a 
selection of notes the entire Log Sheet Heading is 
saved as well), and click the Save Copy As button

1

From the Save Copy As dialog box choose a drive 
and folder in which to copy the log sheet

Enter the required name in the File name box or 
accept the default

2

3

Choose the format from the Save as type list. When 
saving a copy you can choose one of two formats: 
Annotator format and Internet browser format (.htm).

4

After saving a copy the original log sheet remains active.  
To view the copy follow the normal procedure for opening 
a log sheet.

Click Save to save a copy of the log sheet.5

Contents
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M erging Log Sheets

With Annotator you can merge multiple log sheets to create a new log sheet.  The 
heading and column titles of the active log sheet are used to create the heading and 
column titles of the newly merged log sheet.  The Description field is modified with a 

fnew first line containing the word Merged.  When the temporary merged log sheet is 
created it is locked to editing and is not saved.  If you close the merged log sheet it is 
permanently deleted.  If you want to save or edit the merged log sheet then save a 
copy  close the original (which is deleted on closing) and then open the copy   The copy, close the original (which is deleted on closing) and then open the copy.  The 
copy can be switched to edit mode.

To merge log sheets:

Select the log sheet that contain the 
heading information that you want.

S l t M f th T l

Open the log sheets you want to merge. 1

2

3 Select Merge from the Tools menu.

Click Yes in the confirmation dialog box 
to merge the log sheets

3

4
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Filtering Log N otes

The Filter tool provides a way of extracting specific notes from a log sheet.  When the 
filter is activated a new log sheet opens consisting of all the notes that contain the 
selected phrase.  The heading information is the same as the original log sheet.

f fThe temporary filtered log sheet is locked to editing and is not saved. If you want to 
save or edit the filtered log sheet you must save a copy, close the original (which is 
deleted on closing) and then open the copy.  The copy can be switched to edit mode. 
To filter a log sheet:

Select the word or phrase to use as the filter text or 
position the cursor in the required field to use the 
entire field contents as the filter text.

1

From the menu click Tools then Filter or click 
the Tools button and then Filter.

When the confirmation box is displayed, click OK to 
continue.

2

3

The log sheet is scanned and any notes (rows) that 
contain the required filter text, in the same column as the 
required filtered text, are extracted and placed in a new 
active log sheet.
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Linking Content

Linking a log sheet to a recording makes the timestamps available for locating 
specific events in the recording.  It also adds the Range Bar to the log sheet, which 
indicates any Range Start times, Range End times and the most recent log note 

l t t  th  t l ti   A li k d l  h t id  d t   th  relevant to the current playtime.  A linked log sheet provides updates on the 
relationship between the notes and the Current Play Time in the playback panel of 
Recorder or Player.  As the Current Play Time advances the Current Log Note Marker 
automatically jumps to the next relevant log note the instant the log note time is automatically jumps to the next relevant log note the instant the log note time is 
reached.
To link a log sheet:

Open the required log sheet.1 p q g

Click the time stamp for the required log note or
position the cursor in the required log note, click
Actions on the menu bar and then click Link.

If not already started, Annotator automatically

2

launches TheRecordPlayer.  Player then scans the
search folders that have been configured in
Navigator.  If recording content is found with
matching location name and date then it is loaded
and the current play time set to the log sheet
timestamp

3

Contents

timestamp.
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Linked Content

Player scans the Navigator Search Folders 
and loads matching content with the Current 
Play Time control tab is set to the time of the 
selected log note.

The Current Log Note Marker on the log 
sheet Range Bar is positioned next to 
the selected log note.the selected log note.
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Selecting Ranges

If a log sheet is linked to loaded content 
in the Player, you can limit the range of 
content available for review by setting a 
R  St t d R  E d f  th  l  Range Start and Range End from the log 
sheet.  Alternatively you can set a range 
directly in the Player.

Range Start 
Marker

Range End 
Marker

To set the Range Start and the 
Range End right click the relevant 
log notes and click Set Range Start
or Set Range End as required from 
the shortcut menu

Contents

the shortcut menu.
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Synchronizing Log N otes

If a log sheet is created on a different computer from the one that 
created the recording it is possible that a discrepancy exists 
between the log note time stamps and the associated recording 
times.  You can synchronize all timestamps in the log sheet, to the 
correct recording times, in a single step.  Synchronize Sheet is 
available from the shortcut menu when a log sheet is in edit mode 
and the recording loaded in TheRecord Player is linked to the log and the recording loaded in TheRecord Player is linked to the log 
sheet.

It is also possible that a single log note is added too late to match It is also possible that a single log note is added too late to match 
the event in the recording.  Such an incorrectly time stamped log 
note can be synchronized to the actual event in the recording.  
Synchronize Note is available from the shortcut menu when a log y g
sheet is in edit mode and the recording loaded in TheRecord Player 
matches the location name and date of the log sheet.
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Playing Recordings

As you play linked audio the Current 
Log Note Marker moves down the log 
sheet indicating the last log note 
closest to the Current Play Time
control tab.

Current Log Note Marker rests at the 
bottom of the last relevant log note field
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Chapter 4 – Review  Checkpoint

The following list summarizes the skills covered in the previous chapter:The following list summarizes the skills covered in the previous chapter:

�Opening Log Sheets
�Finding Text

�Filtering Log Notes
�Linking Content Finding Text

�Selecting Text
�Copying Log Sheets

Linking Content 
�Selecting Ranges
�Synchronizingpy g g

�Merging Log Sheets
y g

�Playing Recordings
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Chapter 5 -Searching

In this chapter you will find information on the following topics:In this chapter you will find information on the following topics:

Searching for Log Sheets
Managing Log SheetsManaging Log Sheets
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Searching for Log Sheets

Annotator includes powerful searching capabilities to make the location and retrieval 
of specific log sheets fast and efficient.  Simply enter appropriate selection criteria 
and the search function locates all log sheets that contain matching information.  You 
can then copy, delete or print the log sheets without the need to open them.  Finally, 
one or more of the located log sheets can be opened for review.

To start a search select Search… from the File menu of a log sheet.g
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Search Criteria

The Search Criteria help you to find the log sheets that you require. All log sheets 
that match your search criteria are displayed in the search results list.  

Enter text in the Description box that you Enter text in the Log Notes box that you Enter text in the Description box that you 
know can be found in he Description field 
of the required log sheets.

g y
know can be found in he Speaker or Note
fields of the required log sheets.

Enter text in the Location box that you 
k b f d i h L ti fi ldknow can be found in he Location field 
of the required log sheets.

Select a folder in which to search by 
li ki B t t th L k i

Click Search Now to search the 
specified folder for matching log 

clicking Browse next to the  Look in:
box.

p g g
sheets.

You can narrow your search by 
specifying a range of dates.

Search Results List
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Selecting a D ate Range

To reduce the time it takes to search it is recommended that you restrict the search 
period.  Be aware that a search checks the nominated folder and all subfolders.  To 
select a date range you can key dates directly into each date field or you can use the 
calendar control.

Click the list button to open the 
calendar

Select this option to 
restrict the search period

Click here to select today’s date or choose any date as 
required

Contents
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M anaging Log Sheets

The TheRecord Annotator - Search dialog box also provides a simple way to manage 
your log sheets. Once you have completed a search you can open, save a copy, print 
or delete one or more of the log sheets listed in the Search Results list.

Click Print to print the 
selected log sheets

Click Open to open the 
selected log sheets

To select a single log sheet simply 
click the log sheet in the Search 
Results list.

To select multiple log sheets, hold 
the SHIFT key down while clicking 
the first and last log sheets in a 
series of adjacent log sheets.

Click Copy As to copy 
the selected log sheets

Click Delete to delete the 
selected log sheets

To select multiple non-adjacent log 
sheets hold the CTRL key down while 
clicking each required log sheet. 

Contents
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Copying Log Sheets

When saving a copy you can choose one of two formats: Annotator format or Internet 
browser format (.htm) for other users that do not have access to Annotator. Note that 
if you select multiple log sheets then you cannot choose a file name and all log 

h t  t i  th i  i i l sheets retain their original names.
To save copies of one or more log sheets:

From the Save Copy As dialog box  
h th f ld

1
choose the save folder.  

Enter a filename. 2

3

Choose the save format in Save as type:.  
For users with access to Notes, choose the 
log notes format.  For other users copy as a 
HTML file for access in a web browser. 

Click Save.4
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D eleting Log Sheets

As part of managing log sheets it will become necessary, at some point, to delete 
obsolete files.  You can select one or more log sheets for deletion.  Use deletion 
carefully because it is permanent.

To delete one or more log sheets:

Select one or more log sheets.  

C

1

2 Click Delete. 2

3
Click Yes in the confirmation 
dialog box to proceed with the 
deletion. 
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Printing Log Sheets

You can also select and print multiple log sheets from the TheRecord Annotator -
Search dialog box. Each log sheet is printed using the default printer and page setup.  
In a later part of this tutorial you will learn how to print a single log sheet and to 

t bli h i t  d  ttiestablish printer and page settings.
To print one or more log sheets:

Select one or more log sheets.  1

2 Click Print. 

Select a Print range from the Print dialog 
box. You can choose to print a heading 
page (containing the contents of the 
Description, Date and Location fields) 
and/or the log notes. 

3

Click Print…. 4
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Chapter 5 – Review  Checkpoint

The following list summarizes the skills covered in the previous chapter:

�Searching for Log Sheets
�Managing Log Sheets

The following list summarizes the skills covered in the previous chapter:

Managing Log Sheets
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Chapter 6 – Printing Log Sheets

In this chapter you will find information on the following topics:In this chapter you will find information on the following topics:

Printing Log Sheets
Page SetupPage Setup
Printer Setup

Contents



Printing Log Sheets

With Annotator you can print the log sheet or a selection of log notes from the 
active log sheet or you can print multiple log sheets from the 
TheRecord Annotator - Search dialog box.

This section demonstrates printing from the active log sheet.  For details about 
printing from the TheRecord Annotator - Search dialog box see 
Chapter 5 - Searching.

During the print process you can also change the printer setup and page setup.  If 
your on-screen log sheet is too wide for the chosen printer then the log sheet is 
automatically resized to fit the printed page.automatically resized to fit the printed page.

You can also view the print output before printing by selecting Print Preview.
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Printing from  the A ctive Log Sheet

You can print a range of log notes from the active log sheet or you can print the whole 
log sheet.  To select a range of log notes see Chapter 4 – Reviewing Log Sheets.

To print:To print:

If required make a selection of log notes.1

2 Click Print. 

S

Select a Print range from the Print dialog 
box. You can choose to print a heading 
page (containing the contents of the

3 Select a printer and change the properties 
as required.

page (containing the contents of the 
Description, Date and Location fields) 
and/or the log notes.  The log notes 
selection option is only available if you 
previously selected range of notes.

4

Enter the number of copies and the Collate
option if required.

Click OK. 

5

6
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Page Setup

When printing log notes it may be necessary to change the page setup.  Page setup 
controls the margins, headers and footers.

To change the Page Setup:To change the Page Setup:

From the File menu of the annotator 
window click Page Setup.

In the General tab, select Margins and 

1

2

The top and bottom margins apply to all 
text including headers and footers.  Use 
the Heading page options to control the 
printing of headers and footers on the 

Heading page options. 
2

heading page. The heading page 
includes the date, location name and 
the entire contents of the description 
field. 

Click Apply to make the changes 
without closing the Page Setup dialog 
box, or OK to make the changes and 
close the Page Setup dialog box. 

3
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H eader and Footer

To define the header and footer, select the applicable tab and enter the text to be 
inserted by directly keying in your own text or using the predefined Insert buttons.  
For details about the Insert buttons see the TheRecord Annotator User’s Guide.
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Print Preview

Before printing you can preview the output on screen to confirm that the page setup 
and what you are printing is correct.  To preview select Print Preview from the File 
Menu of the Annotator window.

Click Print to print the active 
log sheet and close all 
print dialog boxes.

View other pages by clicking the 
Prev Page and Next Page
buttons as required.

Click Close to close the 
Print Preview
window.
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Chapter 6 – Review  Checkpoint

The following list summarizes the skills covered in the previous chapter:The following list summarizes the skills covered in the previous chapter:

�Printing Log Sheets
�Page SetupPage Setup
�Printer Setup
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Looking Back

This tutorial provided a step-by step introduction and overview of the following 
 d dprocesses and procedures:

� Creating Log Sheets
�� Log Notes
� Reviewing Log Sheets
� SearchingSearching
� Printing Log Sheets

Contents Finish


